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1 Introduction 

This paper documents the integration of WebSphere Application Server (WAS), 
WebSphere Process Server (WPS), WebSphere Message Broker (WMB) and WebSphere 
MQ (WMQ). It uses a fictive order process to verify secured and reliable communication 
among these products in a bi-directional way. Throughout this document the terms 
scenario and showcase are used synonymously. This showcase scenario consists of  
WPS- , WAS- and WMB applications, MQ queues, two user registries (Tivoli Directory 
Server, file-based), and DB2 databases. The applications are deployed on several 
hardware boxes. 
 
The integration considers: 
 

• SSL configuration between WAS, WPS and WMB (refer to chapter SSL 
configuration)  

• Identity propagation and assertion between WAS, WPS and WMB (refer to chapter 
Identity Propagation)   

• JAX-WS and JAX-B clients on WAS for the WPS BPC- and HTM API (refer to 
chapter using JAX-WS and JAX-B clients) 

• Web Service Addressing (WS-A) between WAS and WebSphere Message Broker 
(refer to chapter Web Service Addressing) 

• Integration patterns (refer to chapter Patterns/Interactions)  
o document the detailed implementation steps 
o provide an overview of the interactions from a security point of view in 

chapter Overview of the interactions 
   

 

1.1 Overview of the interactions 

The showcase, as mentioned before, provided for bi-directional interactions between the 
servers and registries, consists of several interactions. The following list provides an 
overview of the interactions: 
 

• Interaction 3 - propagate identity using Username Tokens from WebSphere 
Application Server to WebSphere Process Server via SOAP/http 

• Interaction 4a/d - propagate identity from WPS via MQ to Message Broker. SSL is 
used for transport level security. 

• Interaction 4b/c - propagate identity from WMB via MQ to WAS. SSL is used for 
transport level security. 

• Interaction 5a/d -propagate identity from WPS via MQ to Message Broker. SSL is 
used for transport level security. 

• Interaction 5b/c - identity propagation with identity assertion from WBM to WAS via 
SOAP/https 

• Interaction 7/8 - identity propagation from WPS to WAS via Message Broker. 
identity is propagated via Username Token in the Web Service Security Header. 

• Interaction 11/14 - propagate the identity via LTPA from WAS to WPS with the HTM 
Web Service API. 
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• Interaction 13 - Set up WS-A between WAS and WMB. Https will be used as 
Transport Level Security. Identity propagation will be done using Username Tokens 
(w/o password). 

• Interaction 15/16 - SOAP/MQ; identity propagation not based on process starter 
identity but on HT owner of preceding activity 

• Interaction 17 - SSL with RMI/IIOP; identity propagation between WPS and WAS 
 

Chapter 3 provides an overview about the scenario that we used to demonstrate the 
integration. It contains the operational model and a UML sequence diagram. After getting 
an understanding of the process the reader can refer to those concepts and interactions of 
interest: 
 

• SSL configuration between WAS, WPS and WMB (chapter SSL configuration)  

• Identity propagation and assertion between WAS, WPS and WMB (chapter Identity 
Propagation)   

• JAX-WS and JAX-B clients on WAS for the WPS BPC- and HTM API (chapter using 
JAX-WS and JAX-B clients) 

• Web Service Addressing (WS-A) between WAS and WebSphere Message Broker 
(chapter Web Service Addressing) 

• Integration patterns (chapter Patterns/Interactions) 
o Detailed interaction implementations 
o Chapter interaction 15/16 describes identity propagation of the Human Task 

Owner of the preceding process activity. 
 

 
Find detailed setup and install information in the Appendix. 
 
 

1.2 Scope of the document 

This document shows security related integration aspect of WebSphere Application Server 
(WAS), WebSphere Process Server (WPS), WebSphere Message Broker (WMB) and 
WebSphere MQ (WMQ). It does not document the basic WebSphere installation, 
configuration and implementation. 
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2 Showcase application 

2.1 Operational model 

The high-level system structure for the “showcase” application is shown in the following 
diagram. In this document we do not describe how to install the products.  
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2.2 Overall sequence diagram of the order process application 
(showcase) 

 
The figure below shows the sequence diagram of the scenario. Each interaction step is 
documented in detail in the Patterns/Interactions chapter. 
 
The order process is started by a clerk. He uses a web based client to initiate the process. 
Following this two external systems are used to verify availability of the order item in stock.  
If so, internal order reservation is executed (interactions 1 to 7.1).  
Otherwise an internal purchase order is issued. A purchaser will verify the request, select 
a supplier and submit the external order. Order confirmation automatically updates two 
order databases at the end (interactions 9 to 18). 
 
The arrows in the sequence diagram indicate the request, the chosen protocol, the 
message / request name, whether it is synchronous or asynchronous. The kind of 
processing and protocols also determine the transaction boundaries for the entire 
scenario. 
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3 Identity propagation 

This chapter describes how identity propagation can be done between WebSphere 
Process Server, WebSphere Application Server and WebSphere Message Broker using 
different kind of transport and communication protocols. With identity propagation we 
mean that a user identity is carried within a request call from one system to another 
system. 
 
The following listing provides the interactions described in this document. For the 
implementation refer to chapter Patterns/Interactions.  
 
From To Protocol Pattern/Interaction 
WAS WPS Web Services 3, 11, 14 
WAS WMB Web Service (WS-A) 13 
WAS WMB Web Services 16.1 

WPS WMB MQ 4a, 5a 
WPS WMB Web Services 7 
WPS WAS SOAP/MQ 15 
WPS WAS RMI/IIOP 17 
WPS WAS Web Services 18 
WMB WAS MQ 4b 
WMB WAS Web Services 5b, 8 
 

 

Chapter Interaction 15/16 describes identity propagation of the Human Task Owner of the 
preceding process activity. 
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4 Using JAX-WS clients with the BPC- and HTM API 

In the showcase application we use JAX-WS and JAX-B based clients on WebSphere 
Application Server to access the BPC- and HTM API on WebSphere Process Server.  
 
We show how to propagate the user identity from WAS to WPS - both have different user 
registries - using a programmatic approach and a declarative approach (using JAX-WS 
policy sets). 
  
By using JAX-B on the client we are able to use strong typed business objects with the 
APIs instead of generic ones. 
 

• Using BPC API with JAX-WS (startProcess) refer to Interaction 3. 

• Using HTM API with JAX-WS  (query, claim, complete task)  refer to Interaction 11 
and 14. 
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5 Web Service Addressing (WS-A) 

We demonstrate how to set up WS-A between WAS and WMB with identity propagation 
(Username Tokens). For details refer to chapter Interaction 13.  
 
WS-Addressing is a standardized way of including message routing data within the SOAP 
message. It supports the use of asynchronous interactions by specifying a common SOAP 
header (wsa:ReplyTo) that contains the endpoint reference (EPR) to which the response is 
to be sent. 
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6 SSL Configuration 

Some of the interactions of the showcase use a Secure Socket Layer (SSL) connection between the 
products (WAS, WMQ, WMB and WPS). 
The following SSL configurations are described in this chapter.  

• SSL between WPS/WAS and MQ 

• SSL between WMB and WAS (for http/s between WMB and WAS) 

• SSL between WPS and WAS 

 
 
Refer to IBM WebSphere Developer Technical Journal: SSL, certificate, and key management 
enhancements for even stronger security in WebSphere Application Server V6.1 
 
http://www.ibm.com/developerworks/websphere/techjournal/0612_birk/0612_birk.html 

 

 

6.1 SSL between WPS/WAS and MQ 

 
The option for SSL between MQ and WPS/WAS is to use certificates.  
Therefore we need to generate and exchange certificates at design time. For the WebSphere MQ server 
certificate and for the WPS/WAS server certificate, we will use a self-signed certificate. 
Find an overview of the SSL handshake at 
http://publib.boulder.ibm.com/infocenter/wmqv6/v6r0/index.jsp?topic=/com.ibm.mq.csqzas.doc/sy10660_.ht
m . 
 
The next steps describe the configuration steps to be performed for WPS.  
For SSL between WAS and MQ repeat these steps. 
 
Important: MQ stores the client certificates from its trusted peers (WAS, WPS) not in a separate Trust 
File, but in its keyfile. 
 

6.1.1 Create the self-signed certificate for MQ 

 

1.  Start key management utility ikeyman by opening WebSphere MQ Explorer and right-clicking on IBM 
Websphere MQ, then select Manage SSL Certificates. 
 

 
 

2.  Create the key database file by selecting Key Database File > New 
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3.  Accept the default key database type of CMS 
 

 
 

4.  For the File Name, browse to <mqroot>\Qmgrs\<qmgrname>\ssl\ directory and call the file key.kdb 
 

5.  When prompted, enter an appropriate password (websphere)  
Select the option to stash the password to a file 
 

 
 

6.  Select Create > New Self Signed Certificate.  
 

 
 

7.  Enter a value for the Key Label name as ibmwebspheremq<yourqmgrname_inlowercase>. This will 
end up being the certificate name.  
Also enter values for Common Name (e.g MQServer) 
Organization, and all remaining fields that are labeled optional.  
You can leave the default Key Size of 1024.  
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8.  Enter a filename to store the request or leave the default certreq.arm. The certificate label name must 
follow this convention if using WebSphere MQ V6, otherwise the queue manager will not know which 
server certificate to use 
 

 

 

 

6.1.2 Create the self-signed certificate for WPS 

 

1. Switch to the version of ikeyman that comes with WebSphere Application Server by launching 
<wps root>\bin\ikeyman.bat 
 

2. From the ikeyman menu, select Key Database File > New 
 

3. On the Open dialog, for key database type, accept the default value of JKS (Java™ keystore)  
Save the file as WPSKey.jks 
 

 
 

4. When prompted to create a keystore password, select a valid password and confirm it 
(websphere) 
 

 
 

5. Optional: Delete all signer certificates from the Signer Certificates tab. Limiting signers limits risk. 
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6. Create a new Self-Signed Certificate 
 

 
 

7. Enter data in the Create New Self-Signed certificate dialog with values appropriate to the location 
of your application server. Set Key Label to a value of your choice. Note that the default Validity 
Period is set to 365 days. After 365 days you have to renew the certificates. 
 

 
 

 
 
 
 

6.1.3 Export the self-signed certificate 

 
At this point, we have created a self-signed certificate for the WPS MQ client. We now need to extract the 
jmsclient certificate and place it in the trust file for WebSphere Process Server and WebSphere MQ, so that 
they can both use it as a signer. 
 

1. First, we will export the WPS personal certificate. With the ikeyman database open to the WPSKey file, 
and the jmsclient certificate selected, click Extract Certificate. This exports only the certificate (not the 
private key).  
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2. Save the certificate and give it an appropriate name, such as wps_jms_client.arm 
 

 
 

3. While the WPSKey is used for private keys, we need a trust file which will be will be used for validating 
signers. We will now create this file and call it WPSServerTrustFile. Using ikeyman, create a new key 
database by selecting Key Database File => New and call it WPSServerTrustFile.jks 
 

4. Optional: Switch to the Signer Certificates tab and delete all unnecessary signers 
 

5. Import the jmsclient certificate into the WebSphere Application Server truststore:  
switch to the Signer Certificates tab, press the Add button, browse to the location where you saved 
wps_jms_client.arm, and import the certificate. 
In later point in time, we will also import the MQServer arm file into the WPS trust store. 
 

6. Switch to the MQ keyman 
Import the jmsclient certificate into the WebSphere MQ truststore 
switch to the Signer Certificates tab, press the Add button, browse to was_jms_client.arm, and import 
the certificate 
 

7. Remember that we also need to import the MQ Certificate into the WebSphere Application Server 
truststore, so that the application server can validate the queue manager certificate during the SSL 
handshake 
 

 
 
 
All the certificates are now in the right places for your application server key and trust files. To verify this, 
make sure your application server key file contains the jmsclient certificate, and the application server trust 
file contains the jmsclient certificate and the mqserver certificate. 
 
 

6.1.4 Configure the WebSphere MQ queue manager for SSL 

 

1. Make sure all key files are located in D:\IBM\WebSphere MQ\qmgrs\QM_fmtc7113\ssl\key 
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2. In the MQ Explorer right-click on the queue manager and select Properties > SSL 
 

 
 

3. Verify the Key Repository and click OK 
 

 
 

4. Next, we will configure the channel with which the JMS client will communicate with the queue manager 
for SSL: 
Note that "CN", "OU", "O", and so on, must be uppercase. Also note that PC (postal code) is not an 
accepted part of the DN in WebSphere MQ. Finally, although some areas of the documentation may 
mention that the DN values need to be in quotes, we found in our testing that quoted values such as 
CN='jmsclient' did not work in WebSphere MQ V6 for Windows. 
 

5. In MQ Explorer, select your queue manager, then select the Advanced folder, then the Channels folder, 
and right-click. 
 Select New > Server Connection Channel 
 

 
 

6. On the next dialog, enter a name for the channel (we use SSL.SVRCONN), then click Next. 
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7. Switch to the SSL tab view, and specify a cipher specification. For this example, we will use 
RC4_MD5_US, but you should evaluate your organization's security needs and consider alternative, 
stronger ciphers if necessary. Notice that the default setting for Authentication of parties initiating 
connection is Required  
 

 
 

8. We need to prevent the queue manager from accepting a certificate from simply any client that has a 
certificate issued by one of the CAs in the queue manager's keystore. To do so, we need to set the 
SSLPEER parameter on the channel. This parameter is used to check the Distinguished Name (DN) of 
the certificate from the client at the other end of a WebSphere MQ channel. If the DN received from the 
client does not match the SSLPEER value, the channel will not start. Set this by checking Only accept 
certificates with Distinguished Names matching these values, and enter the DN value that matches the 
client certificate. In our case, this would be: CN=jmsclient,OU=issw,O=ibm,C=US (based on how we 
generated the self-signed client certificate). 
 

 
 
We have now configured the server connection channel that the WPS JMS client will use to communicate 
with the queue manager. If you have not yet done so, you should tighten all channels to require SSL (or 
remove the channel), including channels such as SYSTEM.DEF.SVRCONN 
 
If you have more than one SSL client (as we have in the showcase) and you want to only accept 
request from DNs matching specific values, you have to create additional channels. 
In the showcase we have two SSL channels: 
 

• SSL.SRVCONN for WPS 

• SSLWAS for WAS 
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Certificate security warning 
As you configure certificate keystores for WebSphere MQ, remember that each signing certificate in the 
keystore represents trust between you and that signer (typically a Certificate Authority, CA). In the most 
basic case, placing any signing certificate in the WMQ Server keystore without DN verification means that 
WebSphere MQ should accept all connects from any party that has a certificate from that CA. Unless you are 
using self-signed certificates or have a dedicated CA just for WebSphere MQ, that is almost completely 
insecure. Thus, we restrict the certificates to those with the matching DN value that we specify. That ensures 
that the identity in the certificate is really the identity that we expect. However, there is a catch. If two CAs 
were to issue certificates with the same DN, our security would again be compromised. That should not 
happen since a reputable CA would not do such a thing, but two different CAs might issue certificates with 
the same subject, which is why you need to remove all of the certificates except for the certificate from the 
CA you expect. 
 
 

6.1.5 Configure the WebSphere Application Server JMS client 

 

1. In the WebSphere administrative console, navigate to Security > SSL certificate and key management 
> SSL configurations  
 

2. Select NodeDefaultSSLSettings  
 

3. Select Key stores and certificates 
 

4. Create a new KeyStore by clicking New 
 

 
 

5. Name the new keystore, for example, wpskeystore 
Change path to WPS_INSTALL_ROOT/bin/WPSkey.jks 
Enter a password (e.g websphere) 
Select as Type JKS 
Click OK and Save 
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6. Create a new TrustStore by clicking New 
 

 
 

7. Name the new truststore, for example, wpstruststore 

Change path to WPS_INSTALL_ROOT/bin/WPSServerTrustFile.jks   
Select as Type JKS 
Click OK and Save 
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8. Navigate to Business Integration Security > SSL configurations > NodeDefaultSSLSettings 
Select as Trust store name wpstruststore 
Select as keystore name wpskeystore 
Click OK and save 
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6.2 SSL between WMB and WAS 

This chapter describes how to setup SSL between WMB and WAS for SOAP/HTTPs. 
 

6.2.1 Create Self-Signed Certficate for WAS 

 

1. Switch to the version of ikeyman that comes with WebSphere Application Server by launching <was 
root>\bin\ikeyman.bat 
 

2. From the ikeyman menu, select Key Database File => New 
 

3. On the Open dialog, for key database type, accept the default value of JKS (Java™ keystore). 
 

4. Save the file as WASKey.jks 
 

5. When prompted to create a keystore password, select a valid password and confirm it (websphere) 
 

6. Delete all signer certificates from the Signer Certificates tab. As mentioned earlier, limiting signers limits 
risk 
 

7. Switch to Personal Certificates, and click New Self-Signed 
 

8. Enter data in the Create New Self-Signed certificate dialog with values appropriate to the location of 
your application server. Set Key Label to a value of your choice 

 
 

 

6.2.2 Export the WAS self-signed certificate 

 
At this point, we have created a self-signed certificate for the WebSphere Application Server. We now need 
to extract the certificate and place it in the trust file for WebSphere Application Server and WebSphere MB, 
so that they can both use it as a signer: 
To export the certificate: 
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a. With the ikeyman database open to the WASKey file, and the certificate selected, click Extract 
Certificate. This exports only the certificate (not the private key). 

b. Save the certificate and give it an appropriate name, such as was_soap_server.arm. 
 
 

6.2.3 Import to WMB 

 
 
Refer also to the Info center at  
http://publib.boulder.ibm.com/infocenter/wmbhelp/v6r1m0/index.jsp?topic=/com.ibm.etools.mft.doc/ap12235_
.htm 
 

 
 
1. Adding certificates to the cacerts file 
You must add the certificate for the WAS web service to the cacerts file for Message Broker. This file is the 
default trust store for the broker and is located in the broker's JRE security directory.  
The cacerts file is located in the "%MQSI_FILEPATH%\jre\lib\security" 
 

2. Importing a certificate into the cacerts file 

Use the keytool command to modify the cacerts file: 

1. Click Start > IBM WebSphere Message Broker 6.1 > Command Console to open a broker command 
console 

2. In the command console, type the following command: 

"%MQSI_FILEPATH%\jre\bin\keytool" -import -alias mykey -file name of certificate file -keystore cacerts 
-storepass changeit 

 
where: 
 

• name of certificate file is the fully qualified name of the certificates file. This file is typically found 
in the message broker user's home directory. 

• changeit is the default password for the cacerts file. You can use the keytool command to 
change the password, but, because it is not a configurable property of the broker, the broker 
always attempts to access the cacerts file using the default password changeit. 

 

 

3. 
Verify that the cacerts file was updated by looking at the change date of the cacerts file. 

 

4. Restart WMB 
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6.3 SSL between WPS and WAS 

6.3.1 Configure WPS (client) for SSL 

1
. 

From the administrative console, follow 
Security > SSL certificate and key management > key stores and certificates > NodeDefaultTrustStore > 
Signer certificates > Retrieve from port 

 

2
. 

Enter the remote machine name in the Host field of the WAS server (see screenshot below) 
 

3
. 

Enter CSIV2_SSL_MUTUALAUTH_LISTENER_ADDRESS 9402 of the remote machine as port (see 
screenshot below) 
 

4
. 

Enter Alias for reference (see screenshot below) 
 

5
. 

Click Retrieve signer information to retrieve the keys from WAS 
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6
. 

Apply and save the changes 
 

 

6.3.2 Configure WAS (server) for SSL 

 
1
. 

From the administrative console, follow 
Security > SSL certificate and key management > key stores and certificates > NodeDefaultTrustStore -
> Signer certificates > Retrieve from port 

 
 

2
. 

Enter remote machine name in the Host field(see screenshot below) 

 
3
. 

Enter CSIV2_SSL_MUTUALAUTH_LISTENER_ADDRESS 9402 of the remote machine at Port (see 
screenshot below) 
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4
. 

Enter Alias for reference (see screenshot below) 

 
5
. 

Click Retrieve signer information 

 
 

6
. 

Apply and save the changes 
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7 Patterns (Interactions) 

 

7.1 Sequence of interactions  

In this chapter we describe each step of the showcase. We describe  

• how to configure the specifications for security – on consumer and provider side 

• the implementation of the step in WAS, in WMB, and WPS.  
 
 
 
How to read the configuration steps 
 

o We have chosen the approach which describes specifications in the message flow 
or BPEL application directly with server configuration to show its dependencies. 

 
o The configuration is described from the consumer side first and the corresponding 

settings on the provider side. In some steps it is described the opposite way as the 
settings are driven by the provider side. 
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7.1.1 Interaction 1 to 3 - Start Process 

 
This section describes how to propagate the identity using Username Tokens from WebSphere Application 
Server to WebSphere Process Server via SOAP/http.  

 
Client Application Server Application 

StartProcessEAR_3 (WAS) ShowcaseApp (WPS, BPC Web Service API) 

 
The figure below shows the relevant part in the sequence diagram: 

 
 

 

 
The figure below shows the high-level implementation and configuration steps that have to be performed. 
Find details of the steps in the next sections. 

 

 
 

 

7.1.1.1 Optional implementation 

In this scenario we use Username tokens to propagate the identity. Another option would be to use an LTPA 
token instead the Username Token. Following table lists pros and cons using LTPA- and Username tokens: 



 

Page 29 of 144   

 

 

 

 

 LTPA Token Username Token 
Pro + No SSL required, LTPA Key 

exchange is sufficient 
+ No Realm in token: No Realm mapping 
required, if using different realms 

Con - If different Realms: Realm 
mapping required 

- Identity assertion must be configured, if 
password is not known  
- SSL must be configured 

 

 

7.1.1.2 Detailed description of the implementation and configuration steps 

To configure the Username Token with identity assertion and SSL between WebSphere Application Server 

and WebSphere Process Server, follow the next steps. 

 

 

7.1.1.3 Step 1 – WPS: Develop the BPEL Application and define potential process 
starters 

 
Detailed implementation steps, which are not security relevant, are not described. Refer to the WID artefacts 
to see how the BPEL application is developed. 
 
To define who (users, groups, dynamic staff assignments) is allowed to start a process, an invocation human 
task must be defined on the receive activity of the BPEL process. 
 

1.  In the BPEL editor, click on the Receive activity and select under Properties > Authorization > New to 
create a new invocation human task 

 
 
 

2.  Click on Potential starters and select under Properties the People assignment criteria. In our case it is 
just a User ID. It could be also a Group of users, or a dynamic staff assignment. 
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7.1.1.4 Step 2 – WPS: Deploy BPEL Application  

Detailed deployment steps are described in the appendix. 
 

7.1.1.5 Step 3 – WPS: Modify Token consumer settings on the BPC Container  

 
By default, the Business Process Container application accepts LTPA- and Username Tokens. 
We have to modify the Web Service security bindings of the Username Token consumer to use User Id 
assertion as we do not send the User’s password from WAS to WPS. 
 
The following sequence describes the detailed configuration steps how to modify the Web Service security 
bindings of the Username Token consumer to use User ID assertion for the BPCContainer application. 
 

3.  To modify the security binding click in the Admin Console on  
Applications->Enterprise Applications->BPCContainer_<yourDeploymentTarget> 
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4.  Click Manage Modules 
 

 
 

5.  Click on the module BFIM_<yourDeploymentTarget> 
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6.  Click Web services: Server security bindings 

 
 

7.  Click Edit custom 
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8.  Click Token consumers 
 

 
 
 

9.  Click username_token_con 
 

 
 

10.  Modify the Token consumer class name: Replace the existing entry 
com.ibm.wsspi.wssecurity.token.UsernameTokenConsumer 
with: 
com.ibm.wsspi.wssecurity.token.IDAssertionUsernameTokenConsumer  
and click Apply and JAAS configuration 
 



 

Page 34 of 144   

 

 

 

 
 

11.  Change the JAAS configuration name to 
system.wssecurity.IDAssertionUsernameToken 
Click OK and save 
 

 
 
You have now modified the Web Service security bindings of the Username Token consumer to use User Id 
assertion. 
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7.1.1.6 Step 4 – WAS: Develop Web Service consumer application and define Token 
Generator – JAX RPC  

 
Detailed implementation steps, which are not security relevant, are not described. Refer to the WID artefacts 
to see how the application is developed. 
 
The consumer (WAS) has to send an Asserted Username Token to the BPC Web Service. This is a 
Username Token without password. 
 

1.  To create a Username Token, open the Deployment Descriptor of the StartProcess_Web application 

 

2.  Click the WS Extension tab 
Add a Security Token under Request Generator Configuration 
Select as Token type Username Token 
Local part is filled automatically. 
Click OK 

 
 

3.  Click the tab WS-Security Bindings 
Add a Token Generator under Security Request Generator Configuration 
 
Token Generator Name: TOKEN_GEN  

Token generator class: com.ibm.wsspi.wssecurity.token.UsernameTokenGenerator  

Security Token:           BFM_TOKEN  

Use value type:           Checked  

Callback handler:  Blank    

UserID            Blank  

Password                     Blank    

Callback handler Properties:   

com.ibm.wsspi.wssecurity.token.IDAssertion.isUsed=true  

com.ibm.wsspi.wssecurity.token.IDAssertion.useRunAsIdentity=true 

You'll need to click the Add button to add a row and then select name and value fields to type over. 
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Click OK 

 
4.  Save the deployment descriptor 

 

 

7.1.1.7 Step 4 – WAS: Develop Web Service consumer application and define Token 
Generator – JAX WS 

 
When using JAX-WS you have two options to generate a token: 

• By configuration using policy sets 

• By implementation 
 

Generate the token by programming (this option is implemented in the showcase): 
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This section describes how to use the programmatic approach: 

 

 
public void startProcess() { 

 

  BFMWSService service = new BFMWSService(); 

  BFMIF bfm = service.getBFMWSPort(); 

 

  try { 

enhanceSecurity(bfm, 

com.ibm.websphere.security.auth.WSSubject.getCallerPrincipal(), ""); 

   

  } catch (WSSException e1) { 

   e1.printStackTrace(); 

  } 

    

 

  Order order = new Order(); 

  order.setClientEmail(getClientEmail()); 

  order.setPartNumber(getPartNumber()); 

  order.setPartCount(new Integer(getPartCount())); 

 

  Start start = new Start(); 

  start.setOrder(order); 

 

com.ibm.xmlns.prod.websphere.business_process.services._6.SendMessage 

sendMessage = new ObjectFactory().createSendMessage(); 

  sendMessage.setProcessTemplateName("Showcase"); 

  sendMessage.setPortType(new QName("http://Showcase/Order", "Order")); 

  sendMessage.setOperation("start"); 

  sendMessage.setAny(getElement(start)); 

   

 

com.ibm.xmlns.prod.websphere.business_process.services._6.SendMessageRespons

e response; 

  try { 

   response = bfm.sendMessage(sendMessage); 

   setPiid(response.getPIID()); 

  } catch (ProcessFaultMsg e) { 

   e.printStackTrace(); 

  } 

 

 } 

 

 

 

 
private void enhanceSecurity(BFMIF port, String user, String password) throws 

WSSException { 

  BindingProvider binding = (BindingProvider) port; 

  Map requestContext = binding.getRequestContext(); 

   

  WSSFactory wssFactory = WSSFactory.getInstance(); 

  WSSGenerationContext genContext = wssFactory.newWSSGenerationContext(); 

//UNTGenerateCallbackHandler untCallbackHandler = new 

UNTGenerateCallbackHandler(user, password, true, true); 

UNTGenerateCallbackHandler untCallbackHandler = new 

UNTGenerateCallbackHandler(user, null, true, true); 
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SecurityToken secToken = wssFactory.newSecurityToken(UsernameToken.class, 

untCallbackHandler); 

   

  genContext.add(secToken); 

  genContext.process(requestContext); 

 } 

 

 

Generate the token by configuration  
 
Create a new policy set for Username Tokens. We will not use the default Username Policy set, because it 
will also encrypt the message: 
 

 In the administrative console  click Services – Policy Sets – Application policy sets 
 

 
 
 

Click New 

 
 
 

 Enter a name and click Apply 
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 Click on Add and select WS-Security 

 
 Click Apply and click on WS-Security 

 
 

 Click on Main policy 

 
  

De-select Include timestamp… 
De-select Message Level protection 
Click Apply 
Click Request Token policies 
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 Click on Add Token Type 
Click Username 
 

 
 

 Enter a Token name 
Select as WS-Security version 1.1 
Click Apply 
Save 
 

 
 

 
Bind the policy set to the service client: 

 
 Click on Service clients 

Click on BFMWSService 
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 Select BFMService 
Click Attach and click UNTAsserted 
 

 
 

 Select BFMService 
Click Assign Binding  
Click New 
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 Enter a Name and click WS-Security 
 

 
 
 

 Click on WS-Security 
 

 
 

 Click on Authentication and protection 
 

 
 Click on request:UNT 
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 Add the custom properties: 
 
com.ibm.wsspi.wssecurity.token.IDAssertion.isUsed 
to sent the username without password 
 
com.ibm.wsspi.wssecurity.token.IDAssertion.useRunAsIdentity = true 
to sent the RunAs identity as Username 
 
 

 
 Save 

 

 

7.1.1.8 Step 5 – WAS: Deploy application  

Detailed deployment steps are not described. 
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7.1.2 Interaction 4a and 4d – Check Stock #1 – WPS to Message Broker 

This chapter describes how to propagate a user ID from WPS via MQ to Message Broker.  
SSL is used for transport level security. 
 

Client Application Server Application 

ShowcaseApp (WPS, SCA Import - MQ Binding) CheckStockMQ.mgsflow (WMB) 

 
The figure below shows the relevant part in the sequence diagram: 
 
 

 

 
 

 
The figure below shows the high-level implementation and configuration steps that have to be performed. 
Find details of the steps in the next sections. 

 
 

7.1.2.1 Step 1 – MQ: Define queues 
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Make sure that following queues are defined in MQ: 

 
STOCK_5_INPUT_J2EE 

STOCK_5_INPUT_WPS 

STOCK_5_OUTPUT_J2EE 

STOCK_5_OUTPUT_WPS 

 

7.1.2.2 Step 2 – WPS: Develop the BPEL application 

7.1.2.2.1 Propagate the user ID from WPS to Message Broker 

 
There are three options to propagate the user ID from WPS to Message Broker. 
1. Only Option 1 is implemented in the showcase. 
2. Option 2 is feasible and documented, but not implemented in the showcase. 
3. Option 3 is not feasible and therefore not implemented in the showcase. 

 

7.1.2.2.1.1 Option 1 - User propagation via payload (This is the implemented option in the 
showcase) 

In WPS we put the user ID in the payload of the message using a BO Map. 
The user ID is the user ID of the thread starter (process starter). We use 
WSSubject.getCallerPrincipal()in a custom assign to get the user ID under which the thread runs. 

This field of the BO will be used in the Message Broker to do authorization. 
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7.1.2.2.1.2 Option 2 - User propagation via Custom MQ Header (not implemented) 

In WPS MQ Headers can be produced and modified using mediation components. A username custom 
header (e.g MQRFH2) can be passed via MQ to the Message Broker.  
To create an MQRFH2 in WPS you have to create a mediation module. Within the mediation module an 
MQHeaderSetter node sets the MQRFH2: 
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On the Broker site, the message flow can access and extract the user ID from the MQRFH2 Header field. 
 
 
 

 

 



 

Page 48 of 144   

 

 

 

7.1.2.2.2 Define the ConnectionFactory and queue objects in WID 

 
After the SSL configuration is done (which is described here) configure the MQ import in the SCA Assembly 
Diagram to match the SSL settings. 
 
1. Open the Assembly Diagram in WID and click the MQ Import CheckStockMQ 

At Properties > End-point configuration make sure you use as Server channel the SSL server 
connection channel. 
 

 
 

2. At Security attributes select as Cipher Suite the one you have selected during the MQ SSL 
configuration. 
Enter as Peer name the DN which you have defined during the creation of the certificates. 
 

 
 

 

 

 

 

 

7.1.2.3 Step 3 – WPS: Deploy the BPEL application  

Detailed deployment steps are not described. 
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7.1.2.4 Step 4 – WMB: Develop the message flow and set up a security profile 

Detailed implementation steps, which are not security relevant, are not described. Refer to the WMB Toolkit 
artefacts to see how the message flow application is developed. 
 
If the User Id is provided with the input message, HTTPInput, SOAPInput, or MQInput nodes can be 
examined for an identity field. The identity is used as is, or can be mapped to an alternate identity. This 
identity is used to ensure that the client is authorized to access the message flow. 
Authentication and authorization are performed using an LDAP. The type of security actions to be taken 
(authentication, authorization, and mapping) and the external provider to use are controlled by security 
profiles defined for the broker. 
 
 
Reference Material: 
Using the New Features in WebSphere Message Broker V6.1 
http://www.redbooks.ibm.com/abstracts/redp4458.html 
 

 
In the showcase we can do authentication on the message flow: 
 

1 The input message (csv format) contains the user Id in column 3 of the message 
 

2 A Security Profile on the broker must exist and Authentication must be set to LDAP  
 

 
 

3 Specify in the  MQInput Node: 
identity token type = Username 
identity token location = path to the user ID field 
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4 The Security Profile must be added to the MQ input node of the message flow in the Broker archive. 
 

 
 

 
 

7.1.2.5 Step 5 – WMB: Deploy the message flow application 

Detailed deployment steps are not described. 
 
 

7.1.2.6 Step 6 – SSL configuration between WPS and MQ 

Refer to chapter “SSL between WPS and MQ” 
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7.1.3 Interaction 4b and 4c – Check Stock #1 – Message Broker to WAS 

This scenario describes how to propagate a user ID from WMB via MQ to WAS. 
SSL is used for transport layer security. 
 
The figure below shows the relevant part in the sequence diagram: 
 

 
 
The figure below shows the high-level implementation and configuration steps that have to be performed. 
Find details of the steps in the next sections. 

 

 
 

7.1.3.1 Step 1 – WMQ: Define queues 

 
Make sure that the following queues exist on MQ: 
 

STOCK_5_INPUT_J2EE 
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STOCK_5_INPUT_WPS 

STOCK_5_OUTPUT_J2EE 

STOCK_5_OUTPUT_WPS 

 

 

7.1.3.2 Step 2 – WMB: Develop the message flow 

Detailed implementation steps, which are not security relevant, are not described. Refer to the WMB 
artefacts to see how the application is developed. 
The message flow is just a pass-through flow. 
 

 
 

7.1.3.3 Step 3 – WMB: Deploy the message flow 

Detailed deployment steps are not described. 
 

7.1.3.4 Step 4 – WAS: Develop the WAS application 

Detailed implementation steps, which are not security relevant, are not described. Refer to the WID artefacts 
to see how the application is developed. 

 

7.1.3.5 Step 5 – WAS: Configure the MQ Adapter WAS application 

 
The term “MQ Adapter” means here that we switch the user context of the thread under which the Java MDB 
runs. To do so, the following must be implemented: 
 

1. Parse the MQ input message  
2. Get the user ID from the payload 
3. Switch the user context 

 
 
Parse the MQ input message 
 
   BytesMessage bytesMsg = (BytesMessage) msg; 

   byte[] payloadba = new byte[(int) bytesMsg.getBodyLength()]; 

   int datalen = bytesMsg.readBytes(payloadba); 

   if (datalen != bytesMsg.getBodyLength()) { 

    System.out.println("BodyLength = " + bytesMsg.getBodyLength() 

      + ", but returned data lengt = " + datalen); 

    return; 

   } 

   String payload = new String(payloadba); 

    

   // handle payload 

   String reply = handlePayload(payload); 
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Get the user ID from the payload 
 

 String[] results = payload.split(","); // number,count,user 

 partNumber = results[0]; 

 partCount = results[1]; 

 userId = results[2]; 
 
Switch the User Context 
 

AuthenticationHandler result = null; 

  result = new AuthenticationHandler(); 

  realm = "defaultWIMFileBasedRealm"; 

  try { 

    

   result.setSubject(com.ibm.ws.security.core.ContextManagerFactory 

     .getInstance().login(realm, userId));  

    

   WSSubject.setRunAsSubject(result.getSubject()); 

    

  } catch (WSLoginFailedException e1) { 

   // TODO Auto-generated catch block 

   e1.printStackTrace(); 

  } catch (WSSecurityException e) { 

   // TODO Auto-generated catch block 

   e.printStackTrace(); 

  } 

 

 

7.1.3.6 Step 6 – WAS: Deploy the WAS application 

Detailed deployment steps are not described. 

 

7.1.3.7 Step 7 – SSL Configuration 

Refer to the chapter SSL Configuration. 

 

 

7.1.4 Interaction 5a and 5d – Check Stock #2 – WPS to Message Broker 

 
Client Application Server Application 

ShowcaseApp (WPS, SCA Import - MQ Binding) CheckStockMQ.mgsflow (WMB) 

 

 
The figure below shows the relevant part in the sequence diagram: 
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The figure below shows the high-level implementation and configuration steps that have to be performed. 
Find details of the steps in the next sections. 

 

 

 

 
 
Refer to the Chapter Interaction 4a and 4d – Check Stock #1 – WPS to Message Broker 
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7.1.5 Interaction 5b and 5c – Check Stock #2 – Message Broker to WAS 

 
This chapter describes identity propagation with identity assertion from WBM to WAS via SOAP/HTTP. 

 
Client Application Server Application 

CheckStockMQ.mgsflow (WMB) CheckStock2EAR (WAS) 

 
 

 

 
 
The figure below shows the relevant part in the sequence diagram: 
 

 
 
 
The figure below shows the high-level implementation and configuration steps that have to be performed. 
Find details of the steps in the next sections. 
 

 
 
 
In this scenario a trusted user vouches for the end-user. WebSphere Application Server provides 
functionality that you can use to configure identity assertion and there are different ways in which it can be 
configured. This chapter documents one such way to achieve identity assertion by using a combination of 
transport-level basic authentication and message level Username token where: 
 

• Transport-level basic authentication will be used to carry the credential of the trusted caller and 

• Username Token will be used to carry the identity of the asserted user. 
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7.1.5.1 Step1 – WAS: Develop Web Service provider application and create token 
consumer 

 
WAS, the service provider, expects from the Web Service consumer an asserted Username Token. 
Therefore, we have to configure the deployment descriptor of WAS accordingly. 
 

1. To create a Request Consumer Security Token open the webservice.xml and go to the tab Extension 
 

 
 

2. Open Request Consumer Service Configuration Details > Required Security Token and  
Click Add 
 

 
 

3. Name the token for example AssertedUsernameToken 
Select as Token type Username Token 
Local Part is set automatically when choosing Username Token 
Usage type is Required 
Click OK 
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4. The token is now available in the Required Security Token section 
 

 
 

5. Open the Binding Configurations Tab 
Open Request Consumer Binding Configuration Details > Token Consumer 
Click Add 
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6. • In the Token Consumer dialog box enter a consumer name, e.g AssertedTokenConsumer 

• Select as Token consumer class 
com.ibm.wsspi.wssecurity.token.IDAssertionUsernameTokenConsumer 

• As Security Token select AssertedUsernameToken 

• Check Use value type 

• Select as Value type: Username Token 

• Local Part is generated automatically 

• Check Use.jaas.config 

• Enter as jaas.config name: system.wssecurity.IDAssertionUsernameToken 
by selecting the IDAssertionUsernameToken we define that we just need the user ID, and no 
password   

• Click OK 
 

 
 

 
 

7.1.5.2 Step 2 – WAS: Deploy the application  

 
Detailed deployment steps are described in the appendix.
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7.1.5.3 Step 3 – WMB: Develop the message flow as Web Service consumer 

 
This section describes how to take the identity information from the message body and build a SOAP 
Username Token. The objective is to get a SOAP Message as shown below, which is build in WMB and sent 
to WAS. 
 
<soapenv:Envelope xmlns:show="http://showcase.ibm.com" xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"> 
   <soapenv:Header> 
      <wsse:Security soapenv:mustUnderstand="1" xmlns:wsse="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-
secext-1.0.xsd"> 
         <wsse:UsernameToken wsu:Id="UsernameToken-31775739" xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/oasis-200401-
wss-wssecurity-utility-1.0.xsd"> 
            <wsse:Username>bob</wsse:Username> 
     </wsse:UsernameToken> 
      </wsse:Security> 
   </soapenv:Header> 
   <soapenv:Body> 
      <show:getStock> 
         <partNumber>0</partNumber> 
         <count>0</count> 
      </show:getStock> 
   </soapenv:Body> 
</soapenv:Envelope> 

 
 
To build such SOAP messages with the Username Token, perform the following steps. 
 

1. First, create a Compute Node. The Compute Node extracts the user ID from the input message and 
assigns it to an IdentityMappedToken . The Compute Node will also set the 

IdentityMappedType to username 

Based on both properties, the SOAP request node will later build the SOAP Security Header with a 
(asserted) Username Token. 

 
SET OutputRoot.Properties.IdentityMappedType='username'; 

SET OutputRoot.Properties.IdentityMappedToken= InputRoot.MRM.CSV_Row.CSV_Column[3];  

 

2. To propagate the IdentityMappedType and IdentityMappedTokenType to the SOAP Security Header a 
Policy Set must be created and added to the bar file. Also, a Security Profile must be added to the 
RequestNode: 
 

• Create a Policy Set 

• Right-clickon the broker and select Open Policy Sets 
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3. Add a new Policy Set (for example, Policy_2) and add a new Authentication Token (for example, 
username) 
 

 
 

4. Add a New Policy Set Binding 
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5. Add the Policy set to the BAR: 
Right-click on the cmf file and select Configure 
 

 
 

6. Add the Policy set to the Consumer Policy Set and the Binding to the Consumer Binding 
 

 
 

7. Add the defaultSecurity profile to the RequestNode (the defaultSecurity profile is configured for identity 
propagation): 
In the BAR file Right-click on the Request Node and select Configure 
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8. As Security profile, select Default propagation 
 

 
 

 

7.1.5.4 Step 4 – WMB: Deploy the message flow 

Detailed deployment steps are described in the appendix. 
 

7.1.5.5 Step 5 – SSL configuration between WMB and WAS 

Refer to chapter “SSL between WMB and WAS” 
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7.1.6 Interaction 7 and 8 - SOAP/HTTP from WPS to WAS via Message Broker 

 
This section describes identity propagation from WPS to WAS via Message Broker. identity is propagated via 
Username Token in the Web Service Security Header.  
This section also describes the implementation of an asynchronous SOAP Request from WMB to WAS. 

 
• WPS makes a one-way call with a Username Token to WMB 

• WMB copies the message header (Username Token) and calls WAS 

• WAS sends a response message, which is received by WMB 

• WMB forwards it using a one-way call to WPS 

 

 
 Client Application Server Application 

1 ShowcaseApp (WPS, SCA Import – SOAP/HTTP 
Binding) 

InternalOrder_7Flow.mgsflow (WMB) 

2 InternalOrder_7Flow.mgsflow (WMB) InternalOrder8 (WAS) 

3 InternalOrder_7Flow.mgsflow (WMB) ShowcaseApp (WPS, SCA Export – SOAP/HTTP 
Binding) 

 
The figure below shows the relevant part in the sequence diagram: 
 

 
The figure below shows the high-level implementation and configuration steps that have to be performed. 
Find details of the steps in the next sections. 
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7.1.6.1 Step 1 – WPS: Develop the BPEL application 

Refer to the WID artefacts to see how the full BPEL application is developed. 
 
The process must be configured so that it only accepts responses with the identity of the process 
starter: 
 

1. Add a Authorization Human task to the Receive activity 
 
 

 
 

2. Open the Human Task and select as Potential Starters Users by user ID and as value 
%wf:process.starter% 
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3. Save the Human Task 

 
 

7.1.6.2 Correlation in BPEL 

In this interaction step we use BPEL correlation set to correlate response messages. This section describes 
the implementation of a correlation set in the showcase application. 
 
Reference Material 
 
BPC Samples Page 
http://publib.boulder.ibm.com/bpcsamp/advancedProcessFeatures/correlation.html 

 
 

1. The BPEL contains a one way invoke and a Receive activity. 

 
2. To correlate the response message in the Receive activity, a Correlation Property must be created. 

The Correlation Property specifies the correlation parameters of the request interface and of the response 
interface. 
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3. Also a Correlation Set must be defined, which contains a link to the InternalOrderCorrelationProperty. 
 

 

 
 

4. First, the correlation set must be initialized at the invoke activity 
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5. Second, the correlation set must be used at the receive activity 
 

 
 

6. Now, the BPEL flow is able to correlate the response message to the appropriate process instance. 

 
 

7.1.6.3 Step 2 – WPS: Create a Token Generator 

WMB as service provider expects from the WPS client an asserted Username Token. Therefore, we have to 
configure the deployment descriptor of WPS accordingly. 
 

1. Right-click the showcase SCA Module and select Open Deployment Editor 
 

2. Click the Imports tab 
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3. Click the WS-Security Extension tab 
Add a Security Token under Request Generator Configuration 
Select as Token type Username Token 
Local part is filled automatically. 
 

 
 

4. Click WS-Security Bindings 
Add a Token Generator under Security Request Generator Configuration 
 
Token Generator Name: AssertedTokenGenerator  

Token generator class: com.ibm.wsspi.wssecurity.token.UsernameTokenGenerator  

Security Token:          AssertedToken  

Use value type:          Checked  

Callback handler:  Blank 

UserID              Blank  

Password                    Blank    

Callback handler Properties:   

com.ibm.wsspi.wssecurity.token.IDAssertion.isUsed=true  

com.ibm.wsspi.wssecurity.token.IDAssertion.useRunAsIdentity=true 

You'll need to click the Add button to add a row and  then select name and value fields to type over. 
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7.1.6.4 Step 3 – WPS: Create a Token Consumer  

 
The response to WPS is delivered as Web Service call from WMB to WPS. This means: 

• WPS is Web Service provider 

• WMB is Web Service client 
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We need to deliver in the identity in form of a Username Token from (WAS to) WMB to WPS.  
 
Right-click the showcase SCA Module and select Open Deployment Editor 
 
Click the Exports  tab > WS-Security-Extensions and add a Required Security Token 
 

 
Click the WS-Security Extension tab 
Add a Security Token under Request Generator Configuration 
Select as Token type Username Token 
Local part is filled automatically. 
 

 
 
 
 
Open Request Consumer Binding Configuration Details > Caller Part 
Click Add 
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Switch to the WS-Security Bindings tab and add a new Token Consumer 
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• In the Token Consumer dialog box enter a consumer name, e.g AssertedTokenConsumer 

• Select as Token consumer class 
com.ibm.wsspi.wssecurity.token.IDAssertionUsernameTokenConsumer 

• As Security Token select AssertedUsernameToken 

• Check Use value type 

• Select as Value type: Username Token 

• Local Part is generated automatically 

• Check Use.jaas.config 

• Enter as jaas.config name: system.wssecurity.IDAssertionUsernameToken 
by selecting the IDAssertionUsernameToken we define that we just need the user ID, and no 
password   

• Click OK 
 



 

Page 73 of 144   

 

 

 

 
 

 

 

 

 

7.1.6.5 Step 4 – WPS: Deploy the BPEL application  

Detailed deployment steps are described in the appendix. 
 

7.1.6.6 Step 5 – WAS: Develop the WAS application 

Detailed implementation steps, which are not security relevant, are not described. Refer to the WID artefacts 
to see how the application is developed. 
 

7.1.6.7 Step 6 – WAS: Create the Token Request Consumer 

WAS as service provider expects an asserted Username Token from the client. Therefore, we have to 
configure the deployment descriptor of WAS accordingly. 

 
1. To create a Request Consumer Security Token open the webservice.xml and goto the tab Extension 
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2. Open Request Consumer Service Configuration Details > Required Security Token and  
Click Add 
 

 
 

3. Name the token for example AssertedUsernameToken 
Select as Token type Username Token 
Local Part is set automatically when choosing Username Token 
Usage type is Required 
Click OK 

 
 

4. The token is now available in the Required Security Token section 
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5. Open the Binding Configurations Tab 
Open Request Consumer Binding Configuration Details > Token Consumer 
Click Add 

 
 

6. • In the Token Consumer dialog box enter a consumer name, e.g AssertedTokenConsumer 

• Select as Token consumer class 
com.ibm.wsspi.wssecurity.token.IDAssertionUsernameTokenConsumer 

• As Security Token select AssertedUsernameToken 

• Check Use value type 

• Select as Value type: Username Token 

• Local Part is generated automatically 

• Check Use.jaas.config 

• Enter as jaas.config name: system.wssecurity.IDAssertionUsernameToken 
by selecting the IDAssertionUsernameToken we define that we just need the user ID, and no 
password 

• Click OK 
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7. Open the Extension Tab 
Open Request Consumer Binding Configuration Details > Caller Part 
Click Add 
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7.1.6.8 Step 7 – WAS: Create a Token Response Generator 

1. To create a Response Generator Security Token open the webservice.xml and goto the tab Extension 

 
 

2. Open Request Consumer Service Configuration Details > Required Security Token and  
Click Add 
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3. Name the token for example ResponseAssertionToken 
Select as Token type Username Token 
Local Part is set automatically when choosing Username Token 
Click OK 

 
 

4. The token is now available in the Required Security Token section 
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5. Open the Binding Configurations Tab 
Open Response Generator Binding Configuration Details > Token Consumer 
Click Add 

 
 

6. Token Generator Name: ResponseTokenGenerator 

Token generator class: com.ibm.wsspi.wssecurity.token.UsernameTokenGenerator  

Security Token:            ResponseAssertionToken 

Use value type:          Checked  

Callback handler:  Blank 

UserID              Blank  

Password                    Blank    

Callback handler Properties:   

com.ibm.wsspi.wssecurity.token.IDAssertion.isUsed=true  

com.ibm.wsspi.wssecurity.token.IDAssertion.useRunAsIdentity=true 

You'll need to click the Add button to add a row and  then select name and value fields to type over. 
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7.1.6.9 Step 8 – WAS: Deploy WAS application  

Detailed deployment steps are described in the appendix. 
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7.1.6.10 Step 9 – WMB: Develop MessageFlow  

Message Broker makes an asynchronous SOAP Request to WAS. 
 
The objective is to build a SOAP Message like below, which is sent to WAS. To achieve this, we copy just 
the WS-Security Header from the input node to the output node. 
 
<soapenv:Envelope xmlns:int="http://Showcase/InternalOrder" xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"> 
   <soapenv:Header> 
      <wsse:Security soapenv:mustUnderstand="1" xmlns:wsse="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-
secext-1.0.xsd"> 
         <wsse:UsernameToken wsu:Id="UsernameToken-20140850" xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/oasis-200401-
wss-wssecurity-utility-1.0.xsd"> 
            <wsse:Username>admin</wsse:Username>             
         </wsse:UsernameToken> 
      </wsse:Security> 
   </soapenv:Header> 
   <soapenv:Body> 
      <int:execute> 
         <input1> 
            <!--Optional:--> 
            <partNumber>3</partNumber> 
            <!--Optional:--> 
            <partCount>1</partCount> 
            <!--Optional:--> 
            <repositoryId>1</repositoryId> 
            <!--Optional:--> 
            <clientOrderId>1</clientOrderId> 
         </input1> 
      </int:execute> 
   </soapenv:Body> 
</soapenv:Envelope> 
 
 
 
 

 In the Compute nodes for the request and response flows copy the SOAP input Header into the SOAP 
output header  

 
 
--COPY SOAP UsernameToken 
SET OutputRoot.SOAP.Header = InputRoot.SOAP.Header; 
 

    
 

7.1.6.11 Step 10: Deploy MessageFlow 

Detailed deployment steps are not described 
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7.1.7  Interaction 11 and 14: Human Task – get Supplier – WAS to WPS 

 
This scenario shows how to propagate the user identity via LTPA from WAS to WPS with the HTM Web 
Service API. 
 

Client Application Server Application 

HumanTaskInterface (WAS) ShowcaseApp (HTM Web Service API) 

 
The figure below shows the relevant part in the sequence diagram: 

 

 

 

 

 
The figure below shows the high-level implementation and configuration steps that have to be performed. 
Find details of the steps in the next sections. 
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For all three calls (query, claim, complete) the generic HTM Web Service API is used. 
By default, the HTM Web Service API supports LTPA- and Username Tokens. Therefore, no security-
specific configuration is necessary on WPS side. 
 

7.1.7.1 Step 1 – WPS: Develop the BPEL application and define the potential Human 
Task Owners 

Detailed implementation steps, which are not security relevant, are not described. Refer to the WID artefacts 
to see how the BPEL application is developed. 
 
To define potential HT owners follow the next steps: 
 

  
Open the Human task 
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In the Task you can define Potential Owners. In our case, everybody who is authenticated can claim 
the task. 
 

 
 

 
 

7.1.7.2 Step 2 – WPS: Deploy the BPEL application 

Detailed deployment steps are described in the appendix. 
 

7.1.7.3 Step 3 – WAS: Develop the Web Service client 

Detailed implementation steps, which are not security relevant, are not described. Refer to the WID artefacts 
to see how the BPEL application is developed. 
 

7.1.7.4 Step 4 – WAS: Define the Token Generator – JAX-RPC 
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On the client side (WAS) a Security Token and a Token Generator must be configured. The next steps 
describe how to configure the client application to send an LTPA Token. 
 

 Open the deployment descriptor on the client application 
 

 
 

 In the deployment descriptor open the WS Extension tab, and add a new Security Token 
 

 
 

 Add a new LTPA token 
 

 
 

 Go to the WS Binding tab and add a new Token Generator 
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 Name the Token generator for example LTPA Token Gen 
Select as class com.ibm.wsspi.wssecurity.token.LTPATokenGenerator 
Select as Security Token the LTPA Token 
 
Enable Use value type 
Select as Value type LTPA Token 
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7.1.7.5 Step 4 – WAS: Define Token Generator – JAX-WS 

 
If using JAX-WS you have following two options to generate a LTPA Token: 

- By coding 
- By declaration 

 
This section describes how to use the programmatic approach: 
 
HTMWSService service = new HTMWSService(); 

htm = service.getHTMWSPort(); 

 

try { 

enhanceSecurity(htm, 

com.ibm.websphere.security.auth.WSSubject.getCallerPrincipal(), "");  

  

  } catch (WSSException e1) { 

   e1.printStackTrace(); 

  }  
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...  

 
private void enhanceSecurity(HTMIF port, String user, String password) throws 

WSSException { 

  BindingProvider binding = (BindingProvider) port; 

  Map requestContext = binding.getRequestContext(); 

   

  WSSFactory wssFactory = WSSFactory.getInstance(); 

  WSSGenerationContext genContext = wssFactory.newWSSGenerationContext(); 

//UNTGenerateCallbackHandler untCallbackHandler = new 

UNTGenerateCallbackHandler(user, password, true, true); 

LTPAGenerateCallbackHandler  ltpaCallbackHandler = new 

LTPAGenerateCallbackHandler(user, null); 

   

SecurityToken secToken = wssFactory.newSecurityToken(LTPAToken.class, 

ltpaCallbackHandler); 

   

   

  genContext.add(secToken); 

  genContext.process(requestContext); 

 } 

 
 
 
 

 In the administrative  console, select Policy sets > Application policy sets 
 

 
  

 
 
 
 
 
 

7.1.7.6 Step 5 – WPS: Deploy WAS application 

Detailed deployment steps are described in the appendix. 
 

7.1.7.7 Step 6 – SSL configuration between WPS and WAS 

Refer to chapter “SSL between WPS and WAS” 
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7.1.8 Interaction 13: Web Service Addressing between WAS and WMB  

 
This section describes how to set up WS-A between WAS and WMB. HTTPs will be used as Transport Level 
Security. Identity propagation will be done using Username Tokens (w/o password). 
 
 
Client Application Server Application 

HumanTaskInterface (WAS) Supplier.msgflow (WMB) 

 
The figure below shows the relevant part in the sequence diagram: 
 
 
 

 
 
The figure below shows the high-level implementation and configuration steps that have to be performed. 
Find details of the steps in the next sections. 
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Reference Material 
 

• Web Services Handbook for WebSphere Application Server Version 6.1, Chapter 19 “WS-
Addressing and WS-Resource”, SG24-7257 

• DeveloperWorks Article “Driving WS-Addressing in WebSphere Application Server Version 6.1” at 
http://www.ibm.com/developerworks/webservices/library/ws-soa-wsawsa/ 

 

 
 

7.1.8.1 Step 1 – WMB: Implement the message flow 

 
The SOAPInput node has a property for processing WS-Addressing information present in the incoming 
message called Use WS-Addressing. If you select this property, the WS-Addressing information is processed 
and the process itself is called engaging WS-Addressing. The default is that WS-Addressing is not engaged. 
To enable WS-A support in WMB on a SOAP Input node, open the Properties tab of the SOAP input node 
and select WS Extensions -> Use WS-Addressing (see figure below). 
There is also the option to specify this property in the WSDL. Refer to 
http://publib.boulder.ibm.com/infocenter/wmbhelp/v6r1m0/index.jsp?topic=/com.ibm.etools.mft.doc/ac64500_
.htm. 
 
The SOAPReply node uses WS-Addressing if WS-Addressing is engaged on the SOAPInput node that is 
referenced by the reply identifier of the message entering the reply node. 
The SOAPReply node uses addressing information in the Destination.SOAP.Reply.WSA folder of the local 
environment to determine where to send the reply and with what Message Addressing Properties (MAPs). 
If the Destination.SOAP.Reply.WSA does not exist, or is completely empty when inspected by the 
SOAPReply node, the node uses the default addressing headers that were part of the incoming message. 
Therefore, you do not have to propagate the local environment in the default case, and addressing still works 
as expected. Refer to 
http://publib.boulder.ibm.com/infocenter/wmbhelp/v6r1m0/index.jsp?topic=/com.ibm.etools.mft.doc/ac64510_
.htm 
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7.1.8.2 Step 2 – WMB: Deploy the message flow 

Detailed deployment steps are described in the appendix. 

7.1.8.3 Step 3 – WAS: Configure and implement the WAS application 

 
To make a WS-A call in a Java application, the following basic steps have to be performed: 
 

1. Generate a JAX-RPC client based on the WSDL  
 

2. Set the Input parameters of the SOAP request message 
 

3. Create the SOAP Proxy 
SupplierProxy sp = new SupplierProxy(); 

 

4. Create an Endpoint Reference Object 
EndpointReference epr = null; 

 

5. Create a URI object holding the endpoint  
URI uri = new URI(  

 "http://fmtc7113.boeblingen.de.ibm.com:7800/testwsdlWeb/sca/SupplierExpor

t1"); 

 

6. Add the URI to the EndpointReference object 
epr = com.ibm.wsspi.wsaddressing.EndpointReferenceManager 
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     .createEndpointReference(uri); 

 

7. Create a Stub object 
javax.xml.rpc.Stub stub = ((javax.xml.rpc.Stub) sp.getSupplier()); 

 

8. Set the EPR object as WS-Addressing destination property to the stub  
stub.setProperty(     

 com.ibm.websphere.wsaddressing.WSAConstants.WSADDRESSING_DESTINATION_EPR,

epr); 

 

9. Do the SOAP call and get the response. No extra configuration is needed for the Web services provider 
on WebSphere Application Server 6.1. The application server automatically inserts WS-Addressing 
headers in the response. 
 

10. Find details for 7 to 9 in the code snippet below (step 12, GetSupplierBean.java) 
 

11. The WSDL binding information can specify that WS-Addressing is mandatory or optional: 
<wsdl:binding name="xyzBinding" type="intf:xyzBean"> 
<wsaw:UsingAddressing wsdl:required="false" 
xmlns:wsaw="http://www.w3.org/2006/02/addressing/wsdl"/> 
...... 

When specifying wsdl:required="true" the Web service returns a fault if WS-Addressing information is 
missing in the client request message. If a WebSphere Application Server client sends a message 
without specifying addressing properties the message automatically contains the mandatory WS-
Addressing information. Therefore WebSphere clients do not have to worry about WS-Addressing. 
 

12. GetSupplierBean.java: 

 

 

package com.ibm.wsapitest; 

 

import java.rmi.RemoteException; 

 

import Showcase.Get; 

import Showcase.GetResponse; 

import Showcase.SupplierProxy; 

import Showcase.SupplierRequest; 

 

import com.ibm.websphere.wsaddressing.EndpointReference; 

import com.ibm.websphere.wsaddressing.EndpointReferenceCreationException; 

import java.net.URI; 

import java.net.URISyntaxException; 

 

public class GetSupplierBean { 

 

 String partNumber, partCount, supplierId; 

 

 public String getSupplier() { 

 

  System.out.println("create SOAP Request"); 

  SupplierRequest sr = new SupplierRequest(); 

  sr.setPartCount(1); 

  sr.setPartNumber("123"); 

  Get g = new Get(); 

  g.setInput1(sr); 

  GetResponse res = null; 

 

  System.out.println("create SOAP Proxy"); 

  SupplierProxy sp = new SupplierProxy(); 

 

  EndpointReference epr = null; 

  try { 

 

   URI uri = new URI( 

    

 "http://fmtc7113.boeblingen.de.ibm.com:7800/testwsdlWeb/sca/SupplierExport1"); 

   epr = com.ibm.wsspi.wsaddressing.EndpointReferenceManager 

     .createEndpointReference(uri); 

 

  } catch (EndpointReferenceCreationException e) { 
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   // TODO Auto-generated catch block 

   System.out.println("********************** Error creating erp"); 

   e.printStackTrace(); 

  } catch (URISyntaxException e) { 

   // TODO Auto-generated catch block 

   e.printStackTrace(); 

  } 

  System.out.println("create stub"); 

  javax.xml.rpc.Stub stub = ((javax.xml.rpc.Stub) sp.getSupplier()); 

 

  System.out.println("set stub property"); 

  stub 

    ._setProperty( 

     

 com.ibm.websphere.wsaddressing.WSAConstants.WSADDRESSING_DESTINATION_EPR, 

      epr); 

 

  System.out.println("do SOAP call"); 

  try { 

   res = sp.getSupplier().get(g); 

  } catch (RemoteException e) { 

   // TODO Auto-generated catch block 

   e.printStackTrace(); 

  } 

  String[] response = res.getOutput1(); 

  setSupplierId(response[0]); 

  System.out.println(response[0]); 

  return response[0]; 

 

 } 

 

 public String getPartNumber() { 

  return partNumber; 

 } 

 

 public void setPartNumber(String partNumber) { 

  this.partNumber = partNumber; 

 } 

 

 public String getPartCount() { 

  return partCount; 

 } 

 

 public void setPartCount(String partCount) { 

  this.partCount = partCount; 

 } 

 

 public String getSupplierId() { 

  return supplierId; 

 } 

 

 public void setSupplierId(String supplierId) { 

  this.supplierId = supplierId; 

 } 

 

} 

 

7.1.8.4 Step 4 – WAS: Deploy the application 

Detailed deployment steps are described in the appendix. 
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7.1.9 Interaction 15 and 16 – SOAP/MQ - Identity propagation based on HT owner of 
preceding activity 

 
This step documents: 

• Identity propagation not based on process starter identity but on HT owner of preceding activity 

• SOAP/MQ call from WPS to WAS 

 
 Client Application Server Application 

1 ShowcaseApp (WPS, SCA Import – SOAP/JMS 
Binding) 

InternalSupplierOrder_16 (WAS) 

 
The figure below shows the relevant part in the sequence diagram: 

 

 

 

 
The figure below shows the high-level implementation and configuration steps that have to be performed. 
Find details of the steps in the next sections. 
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7.1.9.1 Step 1 – WPS: Identity propagation based on HT owner of the preceding 
activity 

 
This section demonstrates how to call a service with an HT owner identity of a preceding activity. 

 

 By default, the behaviour is that a invoke is done under the security context of the process starter 

 

 To achieve that the service call is done by the human task owner, we have to add a Java snippet which 
assigns the activity owner of the human task to a BPEL variable. 
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The snippet contains the following code:  
com.ibm.bpe.api.ActivityInstanceData aid = activityInstance("GetSuppliers"); 

HTOwner = aid.getOwner(); 

 
Important: This approach works only with an inline human task. 
 

 The BPEL variable with the HT owner must be added to the payload of the message we will sent to the 
back-end service. 
 

 Now, the back-end service is not invoked directly by the Invoke activity. The invoke will call a mediation 
module. The mediation module is in between the BPEL invoke and the back-end service. 
 

 
 

 The mediation module has one main node:  
 

 
 

 The SOAPHeaderSetter node creates a Username Token Header element and assigns the user ID from 
the payload to it. 
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 To create the Username Token in the security header, first of all you have to add WS-Security schema 
files in the dependencies editor. 
 

 
 

 Then, click the SOAPHeaderSetter node and select Properties > Details > Add.. 
 

 
 

 In the dialog box, select as Action Create and click Browse… 
 

 
 

 Select as Data Type UsernameToken. If you did not add the WS-Security schema file to the 
dependencies, you will not find the UsernameToken here. 
Click OK  
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 Click Next 
 

 
 

 Insert an XPATH expression where to find the user ID in the input message to the value field. 
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 Click Finish and Save 

 
When the Service call is now done using SOAP, the token contains the user ID of the human task owner. 
 
 

7.1.9.2 Step 2 and 3 – WPS: Implement a SOAP/JMS binding 

 
In our showcase we use a SOAP/MQ call. 
 
There are two options to do this: 
 
1. Using a SOAP Datahandler with the MQ binding. However, the disadvantage here is, that just the BO 

itself is converted to a SOAP message and not the SOAP Headers. The SOAP Headers are ignored by 
the Datahandler. Therefore this is not an option for the showcase. 

2. Another option, which we implemented, is to use a SOAP/JMS binding with MQ as JMS provider. Using 
this approach, the SOAP header we set in the mediation is inserted into the SOAP envelope. 
 

 
The JMS/SOAP binding defines Address properties containing destination and queue connection factory.  
 

 
 
 
The queue connection factory is based on MQ: 
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And the destination is also based on MQ: 
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7.1.9.3 Step 4 – WPS: Deploy the BPEL application 

Detailed deployment steps are described in the appendix. 
 

7.1.9.4 Step 5 – WAS: Develop the WAS application 

The WAS application picks up the message from the JMS MQ queue with a message-driven bean. 
The SOAP message is parsed and a new SOAP message is created, which is sent to Message Broker via 
SOAP/HTTP. 

 

7.1.9.5 Step 6 – WAS: Configure MQ Adapter 

 

Refer to chapter 5.9.4.5 Step 5 – WAS: Configure MQ Adapter WAS application 

 

7.1.9.6 Step 7 – WAS: Define Token Generator and Consumer 
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Define Token Generator: 

 
 Open the deployment descriptor on the client application 

 

 In the deployment descriptor open the WS Extension tab, and add a new Security Token 
 

 
 

 Add a new Username token 
 

 
 

 Go to the WS Binding tab and add a new Token Generator 
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 Token Generator Name: AssertedTokenGenerator 

Token generator class: com.ibm.wsspi.wssecurity.token.UsernameTokenGenerator  

Security Token:           AssertedToken 

Use value type:           Checked  

Callback handler:  Blank 

UserID               Blank  

Password                     Blank    

Callback handler Properties:   

com.ibm.wsspi.wssecurity.token.IDAssertion.isUsed=true  

com.ibm.wsspi.wssecurity.token.IDAssertion.useRunAsIdentity=true 

You'll need to click the Add button to add a row and  then select name and value fields to type over. 
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Define Token Consumer: 

 
1. To create a Response Consumer Security Token open the deployment descriptor and goto the tab WS 

Extension 
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2. Open Response Consumer Service Configuration Details > Required Security Token and  
Click Add 

 
 
 
 

3. Name the token for example AssertedUsernameToken 
Select as Token type Username Token 
Local Part is set automatically when choosing Username Token 
Usage type is Required 
Click OK 

 
 

4. Open the WS-Binding Tab 
Open Response Consumer Binding Configuration Details > Token Consumer 
Click Add 

 
 

5. • In the Token Consumer dialog box enter a consumer name, e.g AssertedTokenConsumer 

• Select as Token consumer class 
com.ibm.wsspi.wssecurity.token.IDAssertionUsernameTokenConsumer 
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• As Security Token select AssertedUsernameToken 

• Check Use value type 

• Select as Value type: Username Token 

• Local Part is generated automatically 

• Check Use.jaas.config 

• Enter as jaas.config name: system.wssecurity.IDAssertionUsernameToken 
by selecting the IDAssertionUsernameToken we define that we just need the user ID, and no 
password 

• Click OK 
 

 
 

 

7.1.9.7 Step 8 – WAS: Deploy the WAS application 

Detailed deployment steps are described in the appendix. 

 

7.1.9.8 Step 9 – WMB: Develop the message flow 

 
In the Compute node we copy the SOAP Header to the output message: 
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  --COPY SOAP UsernameToken 

  SET OutputRoot.SOAP.Header = InputRoot.SOAP.Header; 
 

 

 

 

7.1.9.9 Step 10 – WMB: Deploy th message flow 

Detailed deployment steps are described in the appendix. 

 

7.1.10 Interaction  17 – RMI between WPS and WAS  

 
In this section we describe: 

• SSL with RMI/IIOP 

• Identity propagation 
 
 
The figure below shows the relevant part in the sequence diagram: 
 

 
 
The figure below shows the high-level implementation and configuration steps that have to be performed. 
Find details of the steps in the next sections. 
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7.1.10.1 Step 1 – WPS: Develop BPEL application 

To make an EJB call in a SCA application, the following basic steps have to be performed: 
 

1. Add the EJB client as dependency to the SCA module 
 

 
 

2. Create a new import component in the Assembly editor 
 

3. Add the Java remote interface of the bean you want to access 
 



 

Page 109 of 144   

 

 

 

 
 

4. Generate a Enterprise Java Bean binding and name it for example EJBcall_17 
 

5. Add following JNDI name to the EJB binding 
 

 
 

6. EJB bindings can only have Java interfaces, not WSDL interfaces (from WPS 6.2 on they can also 
have WSDL interfaces). BPEL components can only have WSDL interfaces. Therefore we need a 
Java component “WSDL to Java bridge”, which transforms the WSDL interface to a Java interface 
(screenshot #2) 

 
7. To create the “WSDL2Java” component, add a Java component to the Assembly Diagram and add a 

WSDL interface and a Java reference to it. 
o WSDl interface: GlobalOrderingDB 
o Java interface: public interface OrderDBSession extends 

javax.ejb.EJBObject, OrderDBInterface 

 
8. Generate the implementation of the Java component 

 

9. Add following code to access the EJB 
______________________________________________________________________________ 

public String store(DataObject input1) {   

OrderDBRequestData orderDBRequestData = new 
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OrderDBRequestData(input1.getString("clientOrderId"), 

input1.getInt("partCount"), input1.getString("partNumber")); 

   

  //0=OK, 1=NOK   

OrderDBResponseData orderDBResponseData = new OrderDBResponseData(1); 

   

  try {    

orderDBResponseData = 

locateService_OrderDBSessionPartner().createOrderEntry(orderDBRequestDa

ta);   

    

  } catch (RemoteException e) { 

   // TODO Auto-generated catch block 

   e.printStackTrace(); 

  }  

   

  String status;   

  if (orderDBResponseData.getStatus()==0) 

   status = "OK"; 

  else 

   status = "NOK"; 

   

  return status; 

 } 

______________________________________________________________________________ 
 
 

 

 
 

7.1.10.2 Step 2 – WPS: Deploy the BPEL application  

Detailed deployment steps are described in the appendix. 
 

7.1.10.3 Step 3 – WAS: Develop the application 

Detailed implementation steps, which are not security relevant, are not described. Refer to the WID artefacts 

to see how the BPEL application is developed. 
 

7.1.10.4 Step 4 – WAS: Deploy the application  

Detailed deployment steps are described in the appendix. 
 

7.1.10.5 Step 5 – SSL configuration 

Refer to chapter “SSL between WPS and WAS” 
 

7.1.10.6 Step 6 and 7 – Configure CSIv2 authentication 

7.1.10.6.1  Option 1: Basic Authentication and identity assertion 

Option 1 describes how to establish trust between the servers using Basic Authentication and identity 
assertion (technical user ID). Basic Authentication with identity assertion is identity propagation without the 
need for a common authentication infrastructure. For example the sending server and target server do not 
share LTPA keys. 
 
Servers require some form of trust. In this identity assertion scenario the target server authenticates the 
sending server to establish trust. If the server is trustworthy, the target server accepts the asserted identity 
token. Two mechanisms to authenticate trusted user exist: 

1. Basic Authentication (implemented as Option 1 in this showcase) 
� Outbound server’s security ID (technical user ID) and password is sent 
� With WAS V6.1 can specify id to use 
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� Inbound server validates user ID and password in registry 
2. Client Certificate Authentication (not implemented in the showcase) 

� Outbound server’s client certificate (KeyRing used by IIOP) is verified by the 
inbound server, that is, the signing certificate used to sign the client’s certificate 
(whether CA issued or self-signed) must be in the server’s key ring 

� Certificate identity is then mapped to an identity in the receiving server’s registry 
� Then by using the trusted server list, WAS determines if calling server is authorized 

to assert identity 
 
Identity assertion behavior: 

� Outbound server sends the asserted user’s identity as a user ID 
� Inbound server accepts the user’s id and creates credentials by querying its registry 
� No validation is performed on asserted identity (no password, token, etc) 
� Both outbound and inbound servers can insert login modules to customize this process 

� RMI_INBOUND - inbound server’s JAAS login configuration 
� RMI_OUTBOUND – outbound server’s JAAS login configuration 

� Either module can perform identity mapping 
 
 
To configure Basic Authentication with identity assertion you have to configure  

� CSIv2 outbound authentication on caller side (WPS) 
� CSIv2 inbound authentication on provider side (WAS) 

 
 
Configure CSIv2 outbound authentication on caller side (WPS) 
 

1. In the administrative console navigate to Secure administration, applications, and infrastructure > 
RMI/IIOP security > CSIv2 outbound authentication 
 

2. Set Basic Authentication to required 
This option indicates that clients communicating with this server must specify a user ID and password 
for any method request 
 

3. Enable identity assertion 
Specify as alternate trusted identity a technical user that is known on the provider side 
 

4. Disable security attribute propagation 
LTPA is the only authentication mechanism supported when you enable the security attribute 
propagation feature 
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5.  
Save 
 

 
 
 

Configure CSIv2 inbound authentication on provider side (WAS) 
 

1. In the administrative console navigate to Secure administration, applications, and infrastructure > 
RMI/IIOP security > CSIv2 inbound authentication 
 

2. Set Basic Authentication to required 
 

3. Enable identity assertion and enter the trusted identity 
 

4. Disable security attribute propagation 
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The following picture shows both inbound and outbound authentication properties: 
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7.1.10.6.2 Option 2: Basic Authentication without identity assertion 

 
Option 2 describes how to use Basic authentication to authenticate with the current user using LTPA tokens. 
Prerequisite is that the sending server and target server share LTPA keys. 
 

o The client sends an LTPA token to the target server via the IIOP channel.  
o Option 2 is only applicable if both servers share the realm or part of a trusted realm 
o Option 2 is only applicable if both servers share the LTPA key 
 
To configure Basic Authentication with identity assertion you have to configure  

� CSIv2 outbound authentication on caller side (WPS) 
� CSIv2 inbound authentication on provider side (WAS) 

 
 
 
Configure CSIv2 outbound authentication on caller side (WPS) 
 

1. In the administrative console navigate to Secure administration, applications, and infrastructure > 
RMI/IIOP security > CSIv2 outbound authentication 
 

2. Set Basic Authentication to required 
a. Never 

i. This option indicates that this server cannot accept user ID and password 
authentication. 

b. Supported 
i. This option indicates that a client communicating with this server can specify a 

user ID and password. However, a method might be invoked without this type 
of authentication. For example, an anonymous or client certificate might be 
used instead. 
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c. Required 
i. This option indicates that clients communicating with this server must specify a 

user ID and password for any method request. 
 

3. Disable identity assertion 
 

4. Disable security attribute propagation 

 
 
 

5. Save 
 

 
 
 
 
 
Configure CSIv2 inbound authentication on provider side (WAS) 
 

1. In the administrative console navigate to Secure administration, applications, and infrastructure > 
RMI/IIOP security > CSIv2 inbound authentication 
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2. Set Basic Authentication to required 
 

3. disable identity assertion  
 

4. disable security attribute propagation 

 
 
 
 
The following picture shows both inbound and outbound authentication properties: 
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7.1.10.6.3  When to use LTPA, identity assertion, Basic Authentication and Certificates 

 
CSIv2 panel shows: 

• Identity assertion 

• Basic auth 

• Certificate 

• LTPA is implicitly there as an option but not shown. 
 
The recommendations are: 

• If identity assertion is available 
o LTPA token not used or sent for user identity 
o Basic auth or certificate used for server to server authentication 

• If identity assertion is not available 
o LTPA token used if available 
o Basic auth or certificate used if no LTPA is available. 
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7.1.11 Interaction 18 – Update Global Order DB - SOAP HTTPs between WPS and 
WAS 

 
The figure below shows the relevant part in the sequence diagram: 

 

 

 
The figure below shows the high-level implementation and configuration steps that have to be performed. 
Find details of the steps in the next sections.  

 

  
This interaction step is not documented in detail, because it is not security relevant 
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8 Basis setup and application install reference 

8.1 Configuration of JMS resources  

All JMS resources on WPS are generated automatically during deployment of the 
applications. 
 

8.2 Configuration of JDBC resources  

All JDBC resources on WPS are generated automatically during deployment of the 
applications. 
 

8.3 Deployment of the showcase SCA module 

 
For the deployment to WPS we use the default deployment settings: 
 

 

 

 



 

Page 120 of 144   

 

 

 

 

 



 

Page 121 of 144   

 

 

 

 

 



 

Page 122 of 144   

 

 

 

 

 



 

Page 123 of 144   

 

 

 

 

 



 

Page 124 of 144   

 

 

 

 

 



 

Page 125 of 144   

 

 

 

 

 

 



 

Page 126 of 144   

 

 

 

 



 

Page 127 of 144   

 

 

 

 

 



 

Page 128 of 144   

 

 

 

 

 



 

Page 129 of 144   

 

 

 

 

 



 

Page 130 of 144   

 

 

 

 

 

 

 

 

8.4  WebSphere Message Broker resources 

8.4.1 Message Flow definition 

 
Projectname Content Interaction 

Step 
CheckStock_4 CheckStockMQ_5.msgflow 

CheckStockSOAP_6.msgflow 
4a 
5 

InternalOrder_7 InternalOrder_7Flow.msgflow 7 
Supplier_13 Supplier.msgflow 13 
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SupplierOrder_16 SupplierOrder_16.msgflow 15/16 

 

8.4.2 Queue definition 

Name Type Content Interaction 
Step 

STOCK_5_INPUT_J2EE queue  4d 
STOCK_5_INPUT_WPS queue  4c 
STOCK_5_OUTPUT_J2EE queue  4b 
STOCK_5_OUTPUT_WPS queue  4a 

STOCK_6_INPUT_WPS queue  5d 
STOCK_6_OUTPUT_WPS queue  5a 
SUPPLIER_16_INPUT queue  16.1 
SUPPLIER_16_OUTPUT queue  16.1 
 

 

8.5 WebSphere Application Server resources 

 
Projectname Type Content Interaction 

Step  
StartProcessEAR_3 
StartProcessWeb_3 

JSF Start Process 3 

CheckStock1_EAR_5 
CheckStock1MdbEjb_5 

MDB Reads MQ request message ; 
modify payload; sends MQ 
message 

5 

CheckStock2EAR_6 
CheckStock2WAR_6 

Web 
Service 

Returns stock amount, via 
SOAP/HTTP 

6 

InternalOrderEAR_8 
InternalOrderWAR_8 

Web 
Service 

Executes internal order, via 
SOAP/HTTP 

8 

HumanTaskInterfaceEAR_9 
HumanTaskInterfaceWAR_9 

JSF HumanTask Web Service API 
client 

9 

InternalSupplierOrderEAR_16 
InternalSupplierOrderEJB_16 

Web 
Service 
MQ 

 16 

OrderDBEAR_17 
OrderDBEntity 
OrderDBSession 

EntityBean Insert into DB 17 

 
 
 

8.5.1 JMS Connection Factory resources  

 

Create following two JMS Queue Connection Factories: 
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JMS Queues: 
 

 

 

 

8.5.2 Configuration of JDBC resources  
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8.5.3 Configuration of DB2 for WAS applications 

 

To create DB2 tables for the showcase interaction step 17 create DDLs using the Data 
Model in OrderDBEntity: 
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In the showcase we used the db2 admin user ID to access the database during runtime. 
The user needs at least the rights to do sql insert, delete and recover. 
 

8.5.4 Deployment of the WAS applications 

 
For the deployment to WAS we use the default settings of the deployment steps. 
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9 Terms 

 

 

Token A security token represents a set of claims made by a client that 

may include a name, password, identity, key, certificate, group, or 

privilege. Web services security provides a general-purpose 

mechanism to associate security tokens with messages for single-

message authentication. A specific type of security token is not 

required by Web services security 

Username Token A Username Token consists of a user name and, optionally, 

password information 

Asserted (Username) Token A asserted Username Token consists of a user name without 

password information 

LTPA Token Lightweight Third-Party Authentication Token. 

Encrypted Token, carries User identiy. 

Prereq for use is, that servers exchange their LTPA keys. 

Identity assertion When using the identity assertion (IDAssertion) authentication 

method, the security token generated is a <wsse:UsernameToken> 

element that contains a <wsse:Username> element. 

On the request sender side, a callback handler is invoked to generate 

the security token. On the request receiver side, the security token is 

validated. 

Identity propagation An identity is carried within a request call from one system to 

another system 
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10  Abbreviations 

 

BPC Business Process Choreographer 

HTM Human Task Container 

WAS WebSphere Application Server 

WID WebSphere Integration Developer 

WMB WebSphere Message Broker 

MQ WebSphere MQ 

WPS WebSphere Process Server 

 



 

Page 140 of 144   

 

 

 

11 Referenced Documents 

 

 

WPS 
[WPS01] WID info center 

http://publib.boulder.ibm.com/infocenter/dmndhelp/v6r2mx/index.jsp?topic=/com.ibm.wbit.620.hel

p.nav.doc/topics/welcome.html 

 

[WPS02] WPS info center 

http://publib.boulder.ibm.com/infocenter/dmndhelp/v6r2mx/index.jsp?topic=/com.ibm.websphere.

wps.620.doc/welcome_wps.html 

 

[WPS03] Pamela Fong: Asynchronous Processing in WebSphere Process Server, Asynchronous 

processing in WebSphere Process Server 
http://www.ibm.com/developerworks/websphere/library/techarticles/0904_fong/0904_fong.html 

 

[WPS04] IBM Redbook, Using IBM WebSphere Message Broker as an ESB with WebSphere 

Process Server, http://www.redbooks.ibm.com/redbooks/pdfs/sg247527.pdf 

 

 

Message Broker 

[WMB01] WMB info center 

 

[WMB02] IBM Redpaper, Using the New Features in WebSphere Message Broker V6.1, 

http://www.redbooks.ibm.com/abstracts/redp4458.html?Open 

 

[WMB03] Mike Johnson , Signing Flows for WebServices Security, 

http://www.ibm.com/developerworks/library/ws-security/index.html 

Summary:  Set up Web Services Security (WS-Security) for signing data that your applications send 

to and receive from IBM® WebSphere® Message Broker. This article describes basic concepts, 

how to set up the environment, and how to configure WebSphere Message Broker to sign the data. 

The information provided here is platform-independent and operating system-independent, but you 

can see examples of specific operating systems where appropriate. A section on terminology at the 

end of this article helps clarify the concepts described. 

 

[WMB04] Rob Henley, Matthew Golby-Kirk,  

http://www.ibm.com/developerworks/websphere/library/techarticles/0902_henley/0902_henley.htm

l 

Summary: SOAP nodes in WebSphere Message Broker V6.1 send and receive SOAP-based Web 

services messages, enabling a message flow to interact with Web service endpoints. The messages 

may be plain SOAP, SOAP with Attachments (SwA), or Message Transmission Optimization 

Mechanism (MTOM). You can configure the nodes using WSDL, and they support the WS-

Security and WS-Addressing standards. This four-part series describes the SOAP nodes, the logical 

tree for the new SOAP domain, configuration, and runtime behavior. Part 4 describes runtime 

validation, performance, scalability, message flow design, and use of WS-Addressing. 

 



 

Page 141 of 144   

 

 

 

[WMB05] Rob Henley, Matthew Golby-Kirk, SOAP nodes in IBM WebSphere Message Broker 

V6.1, Part 1:  

http://www.ibm.com/developerworks/library/ws-soapnode/index.html 

SOAP nodes send and receive SOAP-based Web services messages, allowing a message flow to 

interact with Web service endpoints. The messages might be plain SOAP, SOAP with Attachments 

(SwA), or Message Transmission Optimization Mechanism (MTOM). The nodes are configured 

using Web Services Description Language (WSDL) and support WS-Security and WS-Addressing. 

This four-part series describes the SOAP nodes, the logical tree for the new SOAP domain, and 

details of configuration and runtime behavior. In this first article, you learn about the basic use of 

the nodes. You should have a general familiarity with SOAP-based Web services and WSDL to 

follow along with this article series.     

 

[WMB06] Rob Henley, (rhenley@uk.ibm.com), Matthew Golby-Kirk (mgk@uk.ibm.com),  SOAP 

nodes in IBM WebSphere Message Broker V6.1, Part 2:  

http://www.ibm.com/developerworks/library/ws-soapnode2/index.html 

This article, Part 2, describes the new logical tree format used by the SOAP domain. You should 

have a general familiarity with SOAP-based Web services and WSDL to follow along with this 

article series. Note: This article relates to IBM WebSphere Message Broker V6.1 Fix Pack 6.1.0.2. 

Some details could differ slightly from the 6.1 GA version.     

 

[WMB07] Rob Henley, (rhenley@uk.ibm.com), Matthew Golby-Kirk (mgk@uk.ibm.com),  SOAP 

Nodes in WebSphere Message Broker V6.1, Part 4: 

http://www.ibm.com/developerworks/websphere/library/techarticles/0902_henley/0902_henley.htm

l 

SOAP nodes in WebSphere Message Broker V6.1 send and receive SOAP-based Web services 

messages, enabling a message flow to interact with Web service endpoints. The messages may be 

plain SOAP, SOAP with Attachments (SwA), or Message Transmission Optimization Mechanism 

(MTOM). You can configure the nodes using WSDL, and they support the WS-Security and WS-

Addressing standards. This four-part series describes the SOAP nodes, the logical tree for the new 

SOAP domain, configuration, and runtime behavior. Part 4 describes runtime validation, 

performance, scalability, message flow design, and use of WS-Addressing. 

 

 

 WAS  

[WAS01] WAS Info Center Web services  security token propagation, 

http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/com.ibm.websphere.expres

s.doc/info/exp/ae/cwbs_securitytokenPropagationwbs.html 

 

[WAS02] WAS Security in General (Technical Library 

http://www.ibm.com/developerworks/views/websphere/libraryview.jsp?end_no=100&lcl_sort_orde

r=desc&type_by=All+Types&sort_order=desc&show_all=false&start_no=1&product_by=WebSph

ere+Application+Servers&search_by=&sort_by=Date&count=100&topic_by=Security&search_fla

g=&show_abstract=true 

 

[WAS04] Keys Botzum, Keys Botzum's Home Page, http://www.keysbotzum.com/ 

 

[WAS05] Web Services Handbook for WebSphere Application Server Version 6.1, Chapter 19 “WS-

Addressing and WS-Resource”, SG247257 



 

Page 142 of 144   

 

 

 

 

[WAS06] DeveloperWorks Article “Driving WS-Addressing in WebSphere Application Server Version 6.1” at 

http://www.ibm.com/developerworks/webservices/library/ws-soa-wsawsa/ 

 

   


